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Quick Start: EtherCAT™ and Commander Series Drives

This application note will describe a step by step procedure to get a motor spinning
on a Commander C300 in vl_velocity mode (2) using TwinCAT™ v.3.

Pre-requisites before running

Ideally, the SI-EtherCAT™ firmware version would match the version of the ESI
files loaded into the TwinCAT™ master’s config folder. An old batch of ESI files
can work with comparatively newer SI-EtherCAT™ modules because the default
setting in the TwinCAT™ 3 scan feature allows for searching device versions
‘equal to or greater than” whatever version of ESI files is already installed in the
master. However, there is no “less than or equal to setting” so the converse
scenario would not work.

***Eor a master device (PC) with an Ethernet port that has never been used
in an EtherCAT™ network, follow Appendix A (page 15) before proceeding
with this procedure***

Procedure

1. Open TwinCAT™ File > New -> Project. Make sure “TwinCAT™ XAE Project
(XML format)” is select as indicated below. Give the project an appropriate
Name. Solution name is automatically filled to match Name. Choose a different
location from default if desired.

New Praject (X

P Recent NET Framework 4.5 ~| sort by: [Defautt -] i [= Search Installed Templates (Ctrl+E; P~
4 Installed

? TwinCAT XAE Project (XML format) TwinCAT Projects Type: TwinCAT Projects
4 Templates =d TWinCAT XAE System Manager
b Other Project Types Configuratien
v TwinCAT Measurement
TwinCAT PLC
= TwinCAT Projects
Samples

© Online

Name: TwinCAT Project]

Location: | - Browse. J

Solution name: TwinCAT Project] Create directory for solution

Cancel |
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2. Expand the 1/0O box in the Solution Explorer (a), right click “Devices” select
“Scan”

w TwinCAT Projectl - Microsoft Visual Studic
FILE EDIT VIEW PROJECT BUILD DEBUG  TWINCAT  TWINSAFE PLC  TOOLS  SCOF

|ﬁ3":'t|'@ J‘| | . -|}Attach...v
i | Build 4022.16 (Loaded) ~| s iy BB 2 X & | @ 7. || <Local»

'|=§§§[

Solution Explorer
W o-a &=
Search Solution Explorer (Ctrl+;)
& Solution 'TwinCAT Projectl' (1 project)
4 ] TwinCAT Projectl
b (@l SYSTEM
MOTION
PLC
(43 SAFETY

‘D Add New Item... Thz
*3  Add Existing ltem... Shift+Alt+A

&' Mappings

Export EAP Config File

Paste
Paste with Links

NOTE: If “Scan Devices...” is greyed out in the dropdown list after right-
clicking, make sure to go into Config Mode by pressing the icon indicated by

(b)-
3. Click OK

Microsoft Visual Studi

HIMT: Mot all types of devices can be found automatically

)
(L oK l) Cancel
—
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4. There should be a list of available EtherCAT™ ports listed below. Select the
required EtherCAT ™port and click OK.

~

[ Device 2 EiherCATT Tlacal Area Connection [T winCAT intel PCT Elhermet 4]

Select Al
Unselect All

5. Click Yes to scan for EtherCAT™ devices in the network. The correct XML files
installed in C:\TwinCAT\Io\EtherCAT will help TwinCAT™ System Manager
correctly identify and name each EtherCAT™ node it detects.

Microsoft Visual Studi

P I
I \_e_\ Scan for boxes I
w

Append linked axis to; @ NG - Configuration
() CMC - Configuration

7. Click No to the Activate Free Run window. This will keep the master in Config
mode.

Microsoft Visual Studia

G~
|'e\ Activate Free Run
L * 4
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8. The system manager will add the Commander C300 as one node along with
other detected nodes in the EtherCAT™ network.

¢ M300Demo - Microsoft Visual Studio
FILE EDIT VEW PROJECT BUILD DEBUG TWINCAT TWINSAFE PLC TOOLS SCOPE  WINDOW  HELP
‘e-o|B-o-2 WX E O]9 -] Atach. - Release -| [TwincaT RT 664) -] A

w0216 Gossed |- i B[ R @] % <o . ]

@ o-a|s- Generol | Adapter | EtherCAT | Online | CoE -Oniins |
Search Solution Explorer (Ctrl+;) P~

131 Solution "M300Deme’ (1 project)
4 il M300Demo

b @l svsTEM Type: EtherCAT Master
MOTION
PLC Comment

Name: Device 2 (EtherCAT) id: 2

Object Id: (03010020

-

(] SAFETY
Cor
4 @Fro
e *EDevlces i
4 = Device 2 (EtherCAT) [F] Disabled Create symbols [7]
*8 Image
+8 Image-Info
b 2 Synclnits
2 Inputs
b [ Outputs
b [ InfoData
T = Box1 (Unidrive M300 Open Loog)

3 ﬁg Mappings

o

T " 0 Errors | 0 Warnings ‘ 0 Messages | Clear

Description

9. For the Commander series general purpose drives, a TwinCAT™ PLC
program must be appended to the project in order to link a TwinCAT™ PLC
variable to one of the transmit (Tx) PDOs. The following will show a very simple
PLC program and a basic variable link to accomplish basic motion of the motor.

10.Right click the PLC block in the “Solution Explorer” and select “Add New
ltem...”

” M300Demo - Microseft Visual Studie
FILE EDIT VIEW PROJECT BUILD DEBUG TWINCAT TWINSAFE PLC TOOLS SCOPE  WINDOW  HELP

fe-ol@-m-2 | [ 9 - @ - » Attach.. - [Release | [TwinCATRT 664,
[Buld 302216 (Loaded) -] st EI| 1 @ @ @ 50| [<Local> -] < M | |

Solution Explorer > I x
@& eo-a &=
Search Solution Explorer (Ctrl+;) P~

] Solution 'M300Deme’ (1 project)
4 ol M300Demo

b @l SYSTEM
MOTION
| ‘O Add NewTtem... Ins
C+| "0 Add Existing Item... Shift+ Alt+A
b BV 2 paste Ctrl+V

Paste with Links
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11.Select “Standard PLC Project,” give the project a name such as “MAIN” and
select a location. Then click on Add.

Add New Item - M300I

— e Sort by: Search Installed Templates (Ctrl+E) P ~
Plc Templates Type: Pl Templates
Standard PLC Project Plc Templates ype: P!
Creates a new TwinCAT PLC project
@ Empty PLC Project Plc Templates containing a task and a program.
— Click here to go onling and find templates.
Location: | - Browse.. |
‘ ! Cancel |

12.Expand “PLC” in the “Solution Explorer” > MAIN - MAIN Project > POUs >
MAIN (PRG).

Solution Explorer
@ o-a| &=
Search Solution Explorer (Ctrl+;) 2~
&1 Sclution 'M300Demo’ (1 project)
4 . M300Demo
b @ SYSTEM
MOTION
4 {@rLC
4 MAIN
.o
b [ External Types
b .5 References
3 DUTs

\ b 3 GVLs
4 [ POUs
3 VISUs
215 MAIN.tmc
b g PlcTask (PlcTask)
I OfF MAIN Instance
| SAFETY
Cos
4 [Fvo
4 Devices
4 7= Device 2 (EtherCAT)
*B Image
*H Image-Info
b 2 SyncUnits
3 Inputs
b [ Outputs
I [ InfoData
b B Box1 (Unidrive M300 Open Loop)
3 ﬁ’ Mappings
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13.Write the following in the MAIN program variable declaration window and the
code below in the MAIN programming window.

man = < [

1 PROGRAM MRIN
= 2 VRAR

3 x:DINT;

4 END VAR

14.Next, go back to the Solution Explorer, go to PLC - MAIN - MAIN Project >
GVL and right click the folder. Select Add - Global Variable List...

04 M300Demo - Microsoft Visual Studio

FLE EDIT VIEW PROJECT BULD DEBUG TWINCAT TWINSAFE PLC TOOLS SCOPE  WINDOW  HELP
©-0|B-a-%wu| [9 - ¢ ~| » attach.. - [Release =] | TwinCAT T (64) A R
Build 402216 (Loaded) -] 5 3 B |1 2 . & ® 7. || <Local> -] 23 [mam - | | | |

Solution Explorer R van = x
o-g| &= 1| PROGRAM MAIN
8l0-8 =
Search Solution Explorer (Ctrl+;) P 3 x:DINT;
[] Solution "M300Demo’ (1 project) END_VAR
4 i M300Demo
b @l sysTEm
=] moTION sSs
\ 1 Xi=X+1r
JAIN
| MAIN Project
» | E pou
;g"““‘ Export to ZIP &) POU for implicit checks..
25 MAIN.tmc
== Import from ZIP DUT...
b G PlcTask (PlcTask) g 2
b 0} MAIN Instance [ Export PLCopenXML. Global Variable List.
SAFETY [ Import PLCopenXML... [B1 Referenced Task..
[ oo+ % o CrrleX & Visualization.
‘ j?—.:OD [ Copy ChrleC Visualization Manager..
P evices
4 = Device2 (EtherCAT) | X Delete Del Gl GlobalTeclist..
28 jmage ¥ Rename . Recipe Manager
m
‘lmaga-lnfu & Properties AteEnter | ‘2] ImagePool.. File
b 2 SyncUnits =0 Interface..
b Inputs .
b oupers '®  Parameter List...
b @ InfoData Q Tetlist..
b Box (Unidrive M300 Open Loop) B Closs Disgram
a
b wh Mappings %1 Existing ltem.. Shift+AlteA
¥ New Folder
[ Existing Folder Content...
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15. After creating a Global Variable List, open it and write the following code in
VAR_GLOBAL to declare the status word which will be linked to Status word
of the SI-EtherCAT™ module.

GVL & > EEFEA

z| VAR GLOBAL
StatusWord_WORD AT:IWL2:WORD:

END VAR

2

4

16.Save your project by going to File > Save All (this saves changes to GVL,
MAIN and any other windows open).

w M300Demo - Microsoft Visual Studic

FILE | EDIT VIEW PROJECT BUILD DEBUG TWINCAT  TWIN
MNew L3 - | p Atti
& e
Add 3 =
Close

Ed  Close Solution =

B SaveGVL Ctrl+5 |_
Save Selected Items As...

@ Save M300Demo as Archive...

\ Send M300Demo by E-Mail...

44 Saveall Ctrl+Shift+5

Export Template...

17.Build the program by opening the Build tab, selecting Build Solution.

o ™

FILE

o - Microsoft Visual Studio
ECT | BULLD | DEBUG

N | B-a-2 W Build Solution
o | Build 402216 (Loaded) ~| <

| Solution Explorer -

TWINCAT  TWINSAFE  PLC

Ctrl+Shift+B

TOOL!

Rebuild Solution

Clean Solution

R] Selution 'M300Demo’ (1 projed
4 | M300Demo
b @l SYSTEM
MOTION
4 PLC

Batch Build...
Configuration Manager...

Check all objects [MAIN]

@ | - = | P Build MAIN |
- -
e Rebuild MAIM |GLOBAL
Search Solution Explorer (Ctrl+;) Clean Selection Status
VAR
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18.Then, go to back to the Solution Explorer, select /0 - Devices - Device
(EtherCAT™) - Box 1 (Commander C300 Open Loop) - Transmit PDO
Mapping 6. Right-click Status Word, select Change Link...

D¢ M300Demo - Microsoft Visual Studio
FILE EDIT VIEW PROJCT BULD DEBUG TWINCAT TWINSAFE PLC TOOLS SCOPE  WINDOW  HELP

0-0|B-0-LUHWH|LE]|2-C | b Atach. - [Release -] [TwinCAT RT 664} i
Build 402216 (Loaded) ~| < g B |12 . @& | ® 7. | [<Local> ~] < [maN - | | |

Solution Explorer SR G = x mamN

@ o-afx- 5z VAR_GLOBAL

Search Solution Explorer (Cirl+. P 3 Statusiiord_WORD ATEIW12:WORD;
3] Solution 'M300Demo’ (L praject) 4| END VAR
4 1l M300Demo

b @8 SYSTEM

k=] MOTION
PLC
4 [ main
4 =] MAIN Project
b [ External Types
b i References
(4 DUTs.
4 [z 6Ws
G v
4 [ POUs
L] MAIN (PRG)
[ VISUs
215 MAIN tmc
b [ PlcTask (PlcTask)
b O] MAINInstance
] SAFETY
[
4 Fwo
4 % Devices
4 =% Device2 (EtherCAT) Description

28 Image
\ % Image-Info
2 Synclnits

Inputs

Pl

Y - | @ o0crors | ¢ 0Warnings | ) 0 Messages | Clear

R

£300 Open Loop)
4 Transmit PDO Mappime
@ Status word
#1 vl velocity actual value 2
b Receive PDO Mapping 6 X Clear Link(s)
b Westate Goto Link Variable
b @ InfoData
b & Mappings

Change Link.

Take Name Over from linked Variable

19. Select the global variable from the PLC program, then click OK.

7 Attach Variable Status word (Input) ==

Show Variables

@ Unused

(0 Used and unused

[T Exclude disabled
Exclude other Devices
xclude same Image
Show Tooltips

[T Sort by Address

[ Show Variable Groups

\

Show Variable Types
[T Matching Type
I Malching Size I
[T Al Types
Amray Maode
Offsets
[7] Continuous
[ Show Dialog
Wariable Name / Comment

/] Hand aver

[ 7] Take over
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20.Go to File and Save All files again.

21.Click on Activate Configuration.

300Demeo - Microsoft Visual Studic
EW  PROJECT BUILD
|| - SR
& |
Solution Explorer
@ o-a| s =
Search Solution Explorer (Ctrl+;)

FILE

fa] Solution 'M300Demo’ (1 project)
4 il M300Demo
b [l SYSTEM
MOTION

22.Click OK on the two windows below. Th
=)

.
Microsoft Visual Studio

\ Activate Configuration
(D1d Configurations will be overwritten!)

Cancel

Activate Configuration

DEBUG  TWINCAT ~ TWINSAFE
o ‘ - = | P Attach.. =
B2 & ®%|[wa

> 0 x

o G R

is will set up Run Mode.

-

===

Microsoft Visual Studio

| Restart TwinCAT System in Run Mode

g OK ! Cancel

23.Click on the PLC tab on the top navbar of the TwinCAT™ 3 window, select

Login.

b M300Demo - Microsoft Visual Studio

FILE EDIT VIEW PROJECT BUILD DEBUG TWINCAT TWINSAFE = PLC
o |B-o-SRE| % Ta]2 -S| » Atach. |
CIE! [ 5 [aou>_ &

@& e-a &= !

Search Solution Explorer (Ctrl+:)

A | a
T3] Solution 'M300Demo’ (1 project) N
4 gl M300Demo

b (@ SYSTEM

5] MAIN Project
b O] MAINInstance

[ saFeTY

Cor
4« Fvo

4 %% Devices

4 = Device 2 (EtherCAT)

*H Image
*H Image-Info
2 SyncUnits

TOOLS
Windows

SCOPE  WINDOW  HELP
Visualization Styles Repository...

Library Repository...

Download
Online Change
Login
Start s
Stop Shift+F5
Logout

Reset cold

Reset origin

Force values

Unforce values

Write values

Project Localization »

Display Mode ,

Inputs

W Outputs

T InfoData

& Box1 (Unidrive M300 Open Loop)
Transmit PDO Mapping 6
&/ Status word
#| vivelocity actual value

LY v Y w

Pl

v

o ]

OErrors | ¢ OW

arnings | @ 19 Messages || Clear
g g

Description
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24.Click Yes and proceed with the download.
[ TwincAT PLC Control s |

Application "Port_851" does not exist on device "M3000emo’. Do you want to create
it and proceed with download?

25.Click on PLC from the navbar, select Start to run the PLC program.

w M300Demeo - Microseft Visual Studio

FILE EDIT VIEW PROJECT BUILD DEBUG  TWINCAT NSAFE | PLC | TOOLS SCOPE WINDOW  HELP
- | i3 - - o W H | | - = | p Atdeh.. = Windows v (6d)
# | Build 402216 (Loaded) ~| < g [ | EX ||w|%, | & Visualization Styles Repository... | 31 »
Library R itory...
Solution Explorer S L [Onlir ) Library Repository.
Download
@ o-a# - o
. Jnline Change
Search Solution Explorer (Ctrl+;) L2 ~ | Expressio Vz
X i “ ot LodNn 0
R Solution 'M300Demo’ (1 project)
4 ] M300Demo b Start F5
b @l sYSTEM Stop Shift+F5
MOTION (3 Logout
B mc ) Reset cold
4 [BFE MAIN — .
b gzl MAIN Project +2)  Reset erigin
b Of MAIN Instance ) Single Cycle
i) SAFETY *=  Flow Control
[
4 1/0 Force values
4 " Devices = Unforce values
4 == Device 2 (EtherCAT) Write values
+ 0l
Image : -
»
+0 Image-Info Project Localization
b 2 SyncUnits Display Mode »
b Inputs
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26. TwinCAT™ PLC control will indicate that it is in a Run state and is Online. The
MAIN program will show updates to the variable created earlier.

_MAIN [Online] + X g N{elID] -

M300Demo.MATH.MAIN
Expression Type Value Prepared value Address Comment E
@ x DINT 14716 B

1 | HTE |=H] 14716 I+1 ; RETURN]

27.In TwinCAT™ Solution Explorer, expand Receive PDO Mapping 6, double left
click vl target velocity (a). The window for this object will open. Click on the
Online tab (b) in this window.

D M300Demo - Microsoft Visual Studic
FLE EDMT VEW PROECT GULD DEBUG TWINCAT TWINSAFE PLC TOOLS SCOPE WINDOW HELP

G-0|B-o-SEd| L@ - @ | b Attach. - Release - T RT 064) -] 2 R smeeEO-.
Build $022.16 (Loaded) - o & | 1 i

B 000eme = x [

MAIN

Solution Bxplorer GVL [Online]

Gl o-d|F = Vasabe |Fiags | Onlne, -
arch Solution Explerer (Ctrl p-
- . Home: l target velocty
57 Solution "M3000eme’ (1 project)
4 gl ME00Deme Tioe: Nt
v @ s G Receive PO Mappng 6 Szs: 20
@ moTion —
. @nc e 2010 User D) 0
4 B M (inkodi,
2] MAIN Project
b [ Extenal Types Commert:
b (i References
3 outs
4 o
@
4 [ POUs
) MAIN (RS
(3 VIBUs ADS o Port: 11, KGp: (3040010, I0fs: E100001C, Len 2
B Matme
» Gh PlcTask (PlcTask)
b Of MAIN Instance Full Mame: THD Device 2 (EtherCAT] Box 1 (Linickive M300 Open Lecp) Receive POU
g sareTy
=<
A e v -| @ arsngs | 14 Mesages | G g D
- 4 = Device 2 (EtherCAT) Descrption Fie Line Column  Project
\ 22 e o e
, & ';‘:’::J::” @2 11/5/2018 12:32:58 PM 984 ms | TwinCAT System’ (10000): Saving configuration of COM server TcEventLogger!
b s (@3 11/5/2018 123259 PM 048 ms | TwinCAT System’ (10000): Shatting down COM Server TeEventLogger |
B Cutputs (04 11/572018 12325 PMGG2 s TuinCAT Syt Q000D Losing cofigurton of COM s
cEventLogger!
4 g ';;:l“:;'mdm 600 Open Loog) 05 111572018 123255 PM664 ms | TwinCAT Syt (1000 niling COM Serves TeEvataggur!
Transmit OO Mapping & 6 11/5/2018 1232:59 PM 674 ms | TwinCAT System’ (0000): TeloEth Server staed: TeloEth.
# Status word 07 11/5/2018 123255 PM 630 ms | TwinCAT System’ (10000): TeRtsObjects Server staned: TeRtsObjects.
vivelocity actual value (@5 11/5/2018 12:32:55 PM 686 ms | TwinCAT System’ (10000): TeloECat Server stated: TeloECat.
+ T RN PDO Mapping & (@5 11/5/2018 123259 PME31 ms | TwinCAT System’ (10000): TCIO Server states TCIO,
& Ol verd 10 11/5/2018 1232:55 PM 700 ms | TwinCAT System’ (10000): TePIc30 Server startec: ToPIc3,
- vi tafe velociny (@ 11 11/5/2018 123259 PM 705 ms | TwinCAT System’ (10000): TCRTIME Server started: TCRTIME.
b Westate 0 12 11/5/2018 12:32:59 PM 748 ms | TCRTIME' (200): Intel(R) Core{TM)-i& th qeneration with interal araphics

11
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28.1n the Online tab, a trace window will appear showing the value of object vi
target velocity. Click on the Write button on the right. In the Set Value Dialog
window, set a Decimal value of 300 as shown below. Click OK. This will set a
300rpm target velocity.

M300Demo + X

Variable | Fags | Crline

™~

Walue: 0
New Value: Release Write...
Comment:
Set Value Dialog &J
pE—
Dec: C e D
Hex: 0u0120
0 Float:
Binary: 2c0 2
Bil Size ®1 0t @1 ©332 O @7

29.Then, navigate to the Solution Explorer, right click Status Word under Transmit
PDO Mapping 6. Click Add to Watch. A watch window will appear showing the
value of the status word in decimal. Use this to diagnose issues with the
following steps.

= [
« Fvo
e,é Devices T - | 0 Errors 0 Warnings | [i BT Messages
4 =% Device 2 (EtherCAT) Description
+0 - .
1 Image 10.75.20129.11 port 32899,
L A Ismagj'l”h 2 11/5/2018 12:32:58 PM 984 ms | TwinCAT System’ (100(
- it .
.o I:”:ts”‘ g 3 11/5/201812:32:59 PM 048 ms | 'TwinCAT System’ (L00(
> O:’t e ¢ 11/5/2018 12:32:50 PM 662 ms | ‘TwinCAT System’ (100(
b @ I E . TcEventlogger !
= B” 01E(ua térive M300 Open Loop) @5 11/5/2018 12:32:50 PM 664 ms | ‘TwinCAT System’ (100(
S Box nidrive pen Loop L - - s
4 T Transmit PDO Mapging 6 6 11/5/2018 12:32:59 PM 674 ms | ‘TwinCAT System’ (100(

22 Status word B0 7 11/5/201812:32:59 PM 650 ms | 'TwinCAT System’ (100(

#| vl velocity actual valu) f8  Change Link...
4 [ Receive PDO Mapping 6 | % Clear Link(s)

ms | TwinCAT System’ (100(
ms | ‘TwinCAT System’ (1000

- Control word
- vl target velocity
> [ WeState
P [E InfoData
4§ Mappings
") MAIN Instance - Device 2 (Ether
+3

Symbol

Goto Link Variable

Take Name Over from linked Variable
Display Mode

Move Address...

Online Write...

Online Force...

Release Force

~ Add to Watch

Remove from Watch

ms | TwinCAT System’ (100(
ms | ‘TwinCAT System’ (1000
ms | 'TCRTIME' (200}: Intel(R

ms | 'License Server' (30: lic
ms | ‘TwinCAT System’ (1000

12
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30.Next, left click on Control Word (a) under Receive PDO Mapping 6. Click on
the Online tab (b) of the window that opens. Click on Write (c). Set a decimal
value of 6 in the Set Value Dialog window, click OK. This will set the control
word to give a Shutdown command. The status word in the watch window
should indicate a decimal value of “560.”
B ME00Oemo - Microsoft Visual Studio

o-o|B-o-Guk| XD b dttach - Relesse || TwinCAT RT 4] || & RrmEseED- .
Build 402216 (Loaded) +| -+ & [ | I ) -

v. 0 14Messages || Cles

Deseription File Line Coumn

T 10752012911 pon 32899,
@2 117572018 123255 PM 384 ms

‘winCAT System’ (10000): Saving configuration of COM sesves TeEventLogges !
ger!

inCAT System’ (10000

pinCAT System’ (L0000
JinCAT System’ (10000): Tcl

31.Enable the C300’s STOs. The status word will now indicate a decimal value of
“561.” The drive keypad will still indicate an Inhibit state. For C200 models, the
status word would skip “560” and go to “561” since all enabling is handled via
EtherCAT™ for those model drives.

32.Click the Write button again, set a decimal value of 7 in the dialog box, click
OK. This will set the control word to give a Switch On command. The status
word in the watch window should indicate a decimal value of “563.”

' -
Set Value Dialog [
e @ D
Hex: 0x0007

Float:

ot (3 (1]

Binary: 07 00 2

Bit Size: ®1 @8 @16 @2 O64 ©?

13
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The C300 drive keypad will indicate a Ready state at this point. If the drive’s
STOs were not enabled before a giving a Switch On command, the status word
should indicate a decimal value of “560” and probably stay there. Start over
from step 30. A C200 drive will indicate a Ready state at this point regardless
of the hardware enable being applied.

33.Click the Write button again, set a decimal value of 15 in the dialog box, click
OK. This will set the control word to give an Enable Operation command. The
status word in the watch window should indicate a decimal value of “567.”

Set Walue Dialog lihj
N D) -
Hew: Q000F Cahcel
Float:

Boal: 1] 1 Hex Edit...
Birnary: OF 00 2
Bit Size: 1 g @16 32 B4 ?

The motor on the drive should now be running at 300 rpm (or 10.0 Hz).

14
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Appendix A: TwinCAT™ Adapter set up

A TwinCAT™ master needs to have an Ethernet port configured with the
TwinCAT™ RT-Ethernet Adapter. Only Ethernet ports with an Intel PCI chip are
compatible with this driver. Typically, a built-in Ethernet port on the PC is
compatible. The following steps will let you find out if your available Ethernet ports

are listed as compatible devices.

1.

Select Devices = Add New ltem...

w TwinCAT Projectl - Microsoft Visual Studio
FILE EDIT VIEW PROJECT BUILD DEBUG  TWINCAT TWINSAFE PLC TOOLS  SCOF

P0-0|B-o-W |9 - @ ~| » Attach.. -
s (] RS e —
Solution Explorer 0 Xx

@& o-a| &=
Search Solution Explorer (Ctrl+;) P~

fa] Solution TwinCAT Project]’ (1 project)
4 ol TWinCAT Projectl
bl SYSTEM
MOTION
PLC
(| SAFETY
Cos
4 [0
i ——
&+ Mappings ‘O Add New Item... Ins

‘0 Add Existing ftem... Shift+Alt+A

Export EAP Config File
“‘\ Scan

Paste

Paste with Links

Select EtherCAT™ master

i
Tnsert Device gw
I. Type: 5= EtheiCAT A =

Y EtherCAT Master
= EtherCAT Slave
= EtheriCAT Automation Protacol (Network Variables)
"] EtherCAT Automation Protecol via ELEEO. EtherCAT

L5 EtherCAT Simulation
i Ethemet
&% Frofibus DF

¥ Profinet
AL CaMopen
= DeviceMeat Target Type
mze Ethelet/P © FC anly

J4f SERCOS interface _
10 Beckholf Lightbus Lo el
-~ USE ) BX only
BT BACRet |- )

S8 Bockiolf Hardware G

m

Name: Device 1
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3. Double left-click the Device 1 (EtherCAT ™) selection that appears. Select the
Adapter tab on the window that appears in the middle pane (a).

D& TwinCAT Projectl - Microsoft Visual Studio
FLE EDIT VIEW PROJECT BULD DEBUG TWINCAT TWINSAFE PLC TOOLS SCOPE  WINDOW  HELP
|B-@-2 | % F a2 - | » atach. - [Release - | [ TwinCAT RT (64) BV

AT e ol | |

@ o-a|s =

General | Adapter | EtherCAT | Oniine | CoE -Online |

Search Solution Explarer (Ctrl+:) p- -

Har g 1
57 Solution ‘TwinCAT Projectl’ (1 project)
4 il TwinCAT Brojectl L Chicct Id 03010010

b @ SvSTEM / Type EtherCAT Master
Commert: -

4 Devices =
p =+ Devicel (EtherCAT)
&7, Mappings

[7] Disabled Create symbols []

Y -| @ 0Erors | 1 0Wamings | ) 0Messages | Clear

Description

4. Select Compatible Devices (a), a window will appear showing a list of available
Ethernet adapters. Click on a device (b) under the “Compatible devices”
section, then hit the Install button (c) on the right. If no compatible devices
appear, you may need to add additional hardware or find a different machine
to operate as a TwinCAT™ master.

D TwinCAT Projectl - Microsoft Visual Studio
FILE EDIT VIEW PROECT BULD DEBUG TWINCAT ~TWINSAFE PLC TOOLS SCOPE  WINDOW HELP
; [B-o-2 @ %D 2| Atach. - [Refease  ~| [TwinCAT RT (:64) -] JmrEEeBD -,
# [Build 402216 (Loaded) ~| o3 B 2@ @[ <o -|= - | | | | 5 H
Solution Explorer R TincAT Projects = x

@lo-a|s- [Gener | Adseter [ EherCAT | Oriine | CoE -Onine

Search Solution Explorer (Ctrl+;) P~

© Network Adapter
[ Solution TwinCAT Projectl’ (1 project)

4 gl TwinCAT Projectl ®@0sMDISy O PC © DPRAM
b @l SVSTEM Descrption
Device Name:

- MAC Address 00000000 00 00 Compatible Devices.
IP Address: 0.0.00(0.0.
D
4 % _W““ Installation of TwinCAT RT-Ethemet Adapters ®
Do + Devicel (EtherCAT) Promiscuous Mode {use with Wireshark only)
@’ Mappings L [F] Vitual Device Names Ethemet Adapters

—— Updale List
& Installd and teady [0 use devicesliealime capable]
a Adapter Reference i Local Area Connection - TwinCAT  rtel PC) Ethemet Adapter (Gigabit)
¥ Installed and ready to use deviceslfor demo use onl)
o
b~ & Incompaible cevices
Froeun Cycle fns). 4

&' Local frea Connection 4 - DrLink DUB-1312/1332 U583,
' Wireless Netwark Connection - Intel[R] CentrinalF)
& Disabled devices

(o |

Y «| @ 0Erors | + 0Wamings | © 0 Messages | Clear
Description C I~ Show Bindings
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5. Once installation is complete, the compatible adapter will become a
TwinCAT™ Ethernet adapter and the “Installed and ready to use devices” will
update with this device. It is recommended that the user close TwinCAT™ 3
and power cycle their machine.
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Appendix B: Example of adding parameters to a PDO

1. Click on the drive icon (a) under Devices. Click on the CoE - Online tab (b).
Click on the Advanced button (c) to open advanced settings.

D¢ M300Demo - Microsoft Visual Studio
FLE EDIT VIEW PROJECT BULD DEBUG TWINCAT TWINSAFE PLC TOOLS SCOPE  WINDOW HELP

co|B-o -2 EP|EE ]2 -] > Atach. - [Release  +| TwinCATRT (64) BV
[Buld 02216 (Loaded) -] - 1 [ | EB | )5 | <toce - < [mam -l -][3] |

Solution Explorer AL Al M300Demo # X

@ o-a| &=

[ General [ BherCAT [ Process Data | Startugl, CoE - Orine [ Onine |
Search Solution Explarer (Ctrl+) o~
7 Solution 'M300Dema’ (L project) L [] Auto Update Single Update [_| Show Offiine Data
4 5] M300Demo b —_— Advanesd Al Objects
bl SYSTEM = Online Data Module OD (AoE Port):
MOTION — .
- PLC C Index Mame Flags Value Unit
4 [ M 1000 Device type RO (40001012 (65538)
b ] MAIN Project 1001 Eror Register RO e (1)
b O MAINInstance # 10180 Ideriiy Obiect RO e
(| SAFETY + 1600:0 Receive PDO Mapping 1 RW >1<
Cos 16010 Recsive PDO Mapping 2 RW >2¢
4 o # 16020 Receive PDO Mapping 3 AW >2¢
4 "’?g Devices + - 1604:0 Receive PDO Mapping 5 RW >2<
4 = Device 2 (EtherCAT) - 16050 Receive FDO Mapping & RW 52¢
*8 Image # 16070 Receive PDO Mapping & RW s1e
*8 Image-Info # 1AD0O  Transmit PDO Mapping 1 RW s1e
b2 SyncUnits # 1ADM0 Transmit DO Mapping 2 RW 52¢
aN b Inputs # 18020 Transmit PDO Mapping 3 W 52¢
b Outputs * 1AD40 Transnt PDO Mapping 5 RW >2¢
b @ InfoDate * 1ADED Tramsmit PDO Mapping 6 RW >2¢

= Box 1 (Unidrive M300 Open Loop)
b [ Transmit PDO Mapping 6
4 [ Receive PDO Mapping 6
- Control word
B vl target velocity
b [ WcState

[ .

2. In the advanced settings window, select Online — via SDO Infromation and
click OK. Wait for TwinCAT™ to load the dictionary (may take a few minutes).

Description

nings ‘019Messagas | Clear

Advanced Settings

[=5=)

Dictionary

@ Orlline - via SDO Information

") Offline -from Device Description

Object
Mappable Objects (FxPDC)
Mappable Objects {TxPDO)
Backup Objects
Settings Objects

@ Device OD
Module OD (via AcE port) |0

Hide Standard Objects
Hide PDO Objects

") Offline - via EDS File

I Error List

T '|01Error |
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3. When it is complete, click on the Process Data tab (a). Click on Transmit PDO
Mapping 6 (b). Right click on an object (c) inside the PDO, select Insert.

D M300Demo - Microsoft Visual Studio
FLE EDT VEW PROECT BULD DEBUG TWINCAT TWINSAFE PLC TOOLS SCOPE WINDOW HELP
-o|B-o-a R X T2 -] b atech. - [Release  ~|[TwinCAT RT (54 BN Jmem=
i 22 tonsen -] S L2 02 o 5 T =y = al oo,

@ eo-a &= General | Eth ess Data | Startup | CoE - Gnine | Onine |
Search s rer (Chrl+2) . 9
Search Solution Explorer (Ctrl+; /P ) TTanscer: DO List
55 Solution 'M300Demo’ (1 project)
4 5l ME0Demo a’ SM  Sze  Type Fag*| |Index  Sze  Name Fags sMo su
> @ 0 256 MbOu GADD 20 Transmt PDO Mapping 1 0
1 256 Mbxin GADT 30 Transmét PDO Mapping 2 0
. 2 4 Outputs 105 Transmit PDO Mapping 6 3 0
3 4 Inputs L 20 Receive PDO Mapping 1 0
4 . 4 0 o 1601 30 Recsive PDO Mapping2 0
-
5 =%
b 50 MAINInstance L 5 1605 40  Recsive PDO Mapping & 2 0
7] SAFETY -1
o b PDO Assignment (B1C12) PDO Contert (Bx1AD5)
4 Fo Eglgg? Index Sie  Offs Name Type Defautt (rex)
4 % Devices & octens
4 =% Device 2 (EtherCAT) ety actual value
+0
’_;mgel . d . Delete..
mage-Info
b 2 SyncUnits Download efined PDO Assignmert: fnone) Edit...
V|
b = Inputs [F1PDO Assigrmert c Load PDO info from device Move Up
b Outputs —
Move D
b @ InfoData ove Jown
4 Box1 (Unidrive M300 Open L
2 |Boc (nilive en Loop) Y - | 3 0Enors | + 0Wamings | € 0Messages | Clear
b [ Transmit PDO Mapping 6
b [ Receive PDO Mapping 6 Description File
b WeState
b @ InfoData
4 &% Mappings
&7, MAIN Instance - Device 2 (EtherCAT) 1

4. Inthe dictionary, select the drive parameter that will be added to Transmit PDO
6. Use the following to decode the objects in the dicitonary from drive
parameters: 0x200A : 65 where A indicates the menu number in hex (10 in
decimal) and 65 indicates parameter number in hex (101 in decimal). Select
and click OK.

Edit Pdo Entry ==

Name: | 0K
Indes hexl O 0

Sub Index: 1]
Data Type: [[none] v]
Bit Lentgh: 1 $

From Dictionary:

0=20071:01 - Parameter 001 -

0=2001:02 - Parameter 002

I 0=2001:03 - Parameter 003 I
0=20071:04 - Parameter 004

0=2001:05 - Parameter 005

0x2001:06 - Parameter 006

0=2001:07 - Parameter 007

0=20071:08 - Parameter 008

0=2001:03 - Parameter 009

0=2007:04 - Parameter 070

0=20071:08 - Parameter 011

0x20071:0C - Parameter 072

0x2001:00 - Parameter 013 -

Faatata It T Y
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5. The selected drive parameter object will appear inside of Transmit PDO
Mapping 6. The example below shows object 0x2002 : 01, which is Pr. 02.001
Post-ramp Reference for a C300 drive.

M300Demo + > LR GVL -
| General | BtherCAT | Process Data | Startup [ CoE - Oniine | Oniine |
Sync Manager: PDO List:
SM  Size Type Aag Index Size Name Flags M su
0 256 MbxOut x1A00 20 Transmit PDO Mapping 1 0
1 256 Mxin Bc1A01 30 Transmit PDO Mapping 2 0
2 4 Qutputs x1AD> 80 Transmit PDO Mapping & 3 0
3 8 Inputs 01600 20 Receive PDO Mapping 1 1]
4 0 QOutputs - 01601 30 Receive PDO Mapping 2 1]
:\ n I de » 1605 40 Receive PDO Mapping & 2 1]
PDO Assignment (I 1C12): PDO Contert ((1AD5):
Dilgg? Indexx Size  Offs Name Type Defaut (hex) -
msns 604100 2.0 0.0 Status word UINT
200201 40 20 Parameter 001 DINT
[e6044:00 2.0 6.0 vl velocity actual value INT -
Download Predefined PDO Assignmert: {none)
Kl
FDO Assignment [Load PDO info from deviee )
PDO Corffiguration
[Syne Unit Assignmet... )
r

6. Clicking on the new object in the Solutions Explorer will show the online trace
of the parameter. Below shows the Post-ramp Reference of 15.00Hz,
indicating that the motor is running. For any issues with this parameter
updating, try re-activating configuration.

¢ WE00Demo - Microsoft Visual Studic.
FLE EDT VEW PROJKCT BULD DEBUG TWINCAT TWINSAFE PLC TOOLS SCOPE WINDOW  HELP

B~ o-2 W@ a9 | b Atach. - [Relesse ~| [TwinCAT RT (64) A
Build 4022.16 (Loaded) ~| = 3 B2 | A | @ 5. | [<Local -] o [man | |

Solution Explorer BEEd V2000emo = X MAIN VL

@ o -a|s = Varable | Fags | Online
Search Solution Explorer (Ctrl+;) P -

Value: 1500
51 Selution M300Deme’ (1 project]
4 4l M300Demo New Value Release Viitie
b (@l sysTEM Comment
=] moTIon ommes

MAIN Project
b O} MAIN Instance
[E] SaFETY
Coe
. m 1500
4 %2 Devices
4 7 Device 2 (EtherCAT)
*® Image

*8 Image-Info

b 2 SyncUnits

b Inputs

b Outputs

b @ InfeData

4 % Box1 (Unidrive M300 Open Loop)

4 [0 Transmit PDO Mapping 6
Status word Error List

|— Parameter 001 Y-

1 vl velocity actual value

| © 19 Messages | Clear

4 W Receive PDO Mapping 6 Description
& Control word @1 Theapplication is up to date
B vl taraet velocits s
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